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Développement d’applications mobiles




Prérequis
@ Architecture d’Android OS ans201>

Objectifs du cours
o Installer et configurer Android Studio
@ Se familiariser avec I'IDE Android Studio
@ Comprendre le cycle de développement d’une application
@ Créer et exécuter une application Android



Outils utilisés dans ce module

@ Android Studio v3.1.4

o JDK 8u181 & jva
o Android SDK - API 28 %
o NOXV6.2.2.0 3



Besoins en matériel

@ 2 Go de mémoire RAM
+ 8 Go de préférence

@ +10 Go d'espace disque pour tout installer

@ Processeur puissant
La puissance pure qui compte le plus rapide sera le mieux

@ 1 coeur devotre processeur est suffisant




Outil de développement

Android Studio v3.1.4 (Aodt 2018)
o Adapté ala programmation Android
e Gourmand en ressource
o Complétion de code avancée

Android
7-’( Studm

Gradle

Intelli/IDEA




Installer Android Studio

1. Installer le JDK (Java SE 8u181)
@ Lien:www.oracle.com/technetwork/java/javase/downloads/index.html

2. Installer Android Studio 3.1.4
e Lien: https://developer.android.com/studio/
@ Chemin : D:\android\android-studio

@

androidstudio

Android Studio provides the fastest tools for building apps on every type of Android device.

I DOWNLOAD ANDROID STUDIO I

3.1.4 for Windows 64-bit (790 MB)

DOWNLOAD OPTIONS RELEASE NOTES


http://www.oracle.com/technetwork/java/javase/downloads/index.html

Installer Android Studio

® Welcom io Android Siudio

1. Récupérer le fichier sdk.zip .»!, ,
e fournidans un flash disk Android Studio

TE Giaark i new Android Siudio projoct

2. Décompressez sdk.zip dans e e ek

¥ Chock out projoct from Version Conirol ~

(* ] D :\ a nd rOid\a nd rOid'Sd k o Impors projec (Gelipse ADT, Gradle, vie.)

¥ Imporisn Android code sample

3. Configurer Android studio
@ Ouvrir Android Studio >
Configure > Project Defaults > Project Structure

@ Indiquer le chemin d’acces du JDK et du Android SDK

Seoid Repositony...
Check for Updaie

Project Defaults > JIEESRTE g9

Run Configurations

L



Définir le chemin d’acces du JDK/SDK

Sous Android Studio :
@ File > Project Structure... > SDK Location

(@)
=
A
=
o

® Project Structure X
+ — SDK Location
Project Android SDK location:
! The directory where the Android SDK is located. This location will be used for new projects, and for existing projects that
Developer Services do not have a local.properties file with a sdk.dir property.
Ads
Authentication | D:\android-sdk\sdk |
Motifications
JDK location:
Maodules ) . .
The directary where the Java Development Kit (JOK) is located.
CE app
[Call scanlibrary [] Use embedded JDK (recommended)
| C:\Program Files\Java\jdk1.8.0_65 | -
Android NDK location:

The directory where the Android NDK is located. This location will be saved as ndk.dir property in the local properties file,

D:\android-sdksdiindk-bundle |D

m | Cancel l




SDK Manager

Sous Android Studio :

VLS WCS 5 =
. EYy¥Yablb x E ?
@ Tools > Android > SDK Manager
® Default Settings b4
CQ 3‘ Appearance & Behavior » System Settings > Android SDK
Appearance & Behavior Manager for the Android SDK and Tools used by Android Studic
Appearance Android SDK Location: | Dvandroid-sdk\sdk Edit
R SDK Platforms | SDK Tools | SDK Update Sites

SE NSRS Each Android SDK Platferm package includes the Android platferm and sources pertaining to an AP level by

Passwords default. Once installed, Android Studio will automatically check for updates. Check "show package details” to
display individual 50K components,

HTTP Proxy
Name AP| Level Revisicn Status
Updates (=] Android 7.1.1 (Nougat)
Usage Statistics Android SDK Platferm 25, rev 3 25 3 Installed
- Sources for Android 25 25 1 Installed
Android SDK [ Android TV Intel x36 Atom System Image 25 3 Not installed
Maotifications [] Android Wear ARM EABI v7a System Image 25 3 Mot installed
o [ Android Wear Intel x86 Atom System Image 25 3 Mot installed
Quick Lists [ Google APIs ARM 64 vBa System Image 25 4 Mot installed
Path Variables [_] Google APIs ARM EABI vTa System Image 25 4 Mot installed
] Google APIs Intel x86 Atom Systemn Image 25 4 Not installed
Keymap [ Google APIs Intel 86 Atom_64 System Image 25 4 Mot installed
Editor [=] Android 7.0 (Nougat)

. [ Google APIs 24 1 Mot installed
LRl Android SDK Platform 24, rev 2 24 2 Installed
Build, Execution, Deployment [ Sources for Android 24 24 1 Not installed

[] Android TV Intel ¥36 Atom System Image 24 10 Mot installed
Tools [_] ARM 64 vBa System Image 24 7 Mot installed
Other Settings Show Package Details

m | Cancel | | Apply | | Help |




Création d’un nouveau projet (1/2)

@ Application Name : LearnApp

@ Compagny Domain : iam.sci
Package: sci.iam.learnapp

@ Project location : D:\android\projects

- TaxiAppindroid - [D\Mes projets, 1-[app] - ..\apphsrcimain'ja
|F18 Edit View Mavigate Code Analyze RBefactor Build Run Teols VC5 ¥

J Open.. CtreMaj+Q  Import Project... Minimum SDK | API 15: Android 4.0.3 (IceCreamSandwich)
Open Recent b Project from Version Control

Lower AP| levels target more devices, but have fewer fez

Close Project
' New Module.. By targeting API 153 and later, your app will run on apprc
Link C++ Project with Gradle Import Module... that are active on the Google Play Store,
S5 Settings... Ctrl+Alt+S Import Sample... Help me choose
% Project Structure... Ctrl+Alt+Maj+5 (£ Java Class () Wear
Other Settings » & Android resource file

[ Android resource directory inirmm SNE | APl 27: Android 5.0 (1 allinom

Import Settings...
p g r—"l -



Création d’un nouveau projet (2/2)

® Create New Project

H‘ Add an Activity to Mobile

Add No Activity

Creates a new empty activity

Basic Activity Empty Activity Fullscreen Activity Google AdMob Ads Activity .

- - Activity Name: | LoginActivity

Generate Layout File

J Layout Mame: | activity_login

Google Maps Activity Login Activity Master/Detail Flow Navigation Drawer Activity Scrolling Activity

[ previous | (IS [ o | [ rinen




Structure d’un projet (1/2)

@ Un projet Android possede
une structure semblable a
MVC, en séparant la vue du
contrble

o Cette structure permet
d’organiser le projet en 3
couches:

@ Présentation
e Logique
@ Données

Logic 'Presentation

Data

Theme

Layoul

Fareground

Background

Runtirme

Persisted




Structure d’un projet (2/2)

app

manifests Manifest

java
scliam.learnapp o )
& % LoginActivity Fichiers java
sciiam.learnapp (androidTest)
scl.lam.learnapp (test)

res
drawable
layout Ressources organisées
¢s activity_loeginxml (texte, ...
mipmap
values

** Gradle Scripts Gradle




Processus de développement (1/2)

Compilation du code source
e Ecrit enJava et compilé en Dalvik bytecode (.dex)

Archivage (Packaging)
@ Archive .apk

Signature
e Les applications doivent étre signées pour étre déployées (pas nécessaire en
mode développement)
Exécution
o Surun support mobile physique (smartphone par exemple)
o Surun émulateur

Android Package (.apk)

.dex MesSources
) Tiles Arsc ADE )
Android d Compilation - 4 Signing Device or
Projact and Packaging uncompiled Emulator
resources

| AndroidManifest i |




Processus de développement (2/2)

Application
Reources

aapt

4

R.java

Application
Source Code

Java
Interfaces

Compiled
Resources

Java
Compiler

.class Files

-

.aidl Files

.dex files

apkbuilder

3rd Party
Libraries

and .class
Files

Android Package
(.apk)

Other Resources




Processus de développement (2/2)

dex files

apkbuilder

Android Package
(-apk)

Compiled
Resources

! Other Resources

|

|

L)
Debug or
Jarsigner Release
Keystore

‘ Signed .apk ’

Zipalign
(release
mode

‘ Signed and ’

Aligned .apk




Exécution sur ’'émulateur intégré (1/4)

VCS5 Window Help

Ibﬁu‘»fbﬁl.’@f‘f‘i

AVD (Android Virtual Device)
e AVD Manager
@ Lentaudémarrage et al'usage
@ Gourmant en ressources
o

Emulation vs. simulation

Fonctionnalités non-disponibles
o Appels téléphoniques réels
Capteurs en général

o
@ Connexions USB

o Evolution de la charge de la batterie
o




Exécution sur I’'émulateur intégré (2/4)

Création d’un nouvel émulateur fourni par le SDK

2.

Vérifier I'image de I'émulateur
@ Ouvrir le SDK Manager

@ Android 8.0 > Intel x86 Atom System Image >

installer le package (si nécessaire)

Créer un AVD

® Android Virtual Device Manager = O X

Virtual devices allow you to test your application without having to
own the physical devices.

I = Create Virtual Device... J

To nrioritive which devices to test vour annlicatinn on visit the

@.
Category Name ~ Size Resolution Den

v Mexus S 40" 4230x200 hdpi

Wear MNexus One NG 480x800 hdpi
Mexus 6P 57" 14402560 560dpi
Tablet Mexus 6 5,96" 1440x2560 560dpi
Mexus 5 52" 1080x1920 420dpi

MNexus 4 a7 T68x1280 xhdpi

Galaxy Nexus 465" T720x1220 xhdpi

54" FWVGA 54" 480x254 mdpi




Exécution sur I"émulateur intégré (3/4

Création d’un nouvel émulateur fourni par le SDK

LS

System Image

Select a system image

Release Name API Level ™ ABI Target
Marshmallow Android 6.0 (with Google APIs]
Marshmallow %86 Android 6.0
Marshmallow 23 xB6_64 Android 6.0
[] Show dewnloadable system images [#s) |

Marshmallow

APl Level

23

L1
® ) ..

? 6.0
| ] Android Open

Source Project

System Image

armeabi-v7a

ecommendation

Consider using a system image with Google APIs to
enable testing with Google Play Services.

Questions on APl level?
See the APl level distribution chart

Android Virtual Device (AVD

Verity Configuration

Use Host GPU

[ Store a snapshet for faster startup
¥ou can either use Host GPU or Snapshots

RAM: 1536 MB ‘
et torage i

SD card: © Studio-managed 100]

Hide Advanced Settings |

Built-in SD Card Size

The amount of removable space available to store data on the
device. We recommend at least 100ME in order to use the
camera in the emulator.

Recemmendatien
Consider using a system image with Google APs to
ensble testing with Google Play Services.




Exécution sur I’'émulateur intégré (4/4)

Accélérer I'émulateur sous Intel

1. Activer la virtualisation dans le BIOS
@ Redémarrer le PC et accéder au bios

@ System Configuration > VT-x > Enable

2. Télécharger I'accélérateur Intel HAXM
@ Ouvrir le SDK Manager
@ Installer le package Intel x86 Emulator Accelerator (HAXM installer)

3. Installer I'accélérateur Intel HAXM

o Allera
[Android_SDK]\extras\intel\Hardware_Accelerated_ Execution_Manager

o Installer intelhaxm-android.exe



Exécution sur l’'émulateur externe

e Rapide en lancement
@ Moins gourmant en mémoire

Ea® ~ @&

Play Store Google Settings Play Games

NOX App Player v5.2.2.0 (6 aoiit 2018)
e Gratuit
e Lien: http://fr.bignox.com
@ Version Android : 4.4.2

GenyMotionv2.12.1 (9 mai 2018) @
e Payant

Lien : https://www.genymotion.com/

°
@ Multi-version
@ Fonctionne sous Oracle VM VirtualBox



http://fr.bignox.com/
https://www.genymotion.com/

Exécution sur un appareil mobile (1/5)

Fonctionnalités de base
o Capteurs et composants intégrés (Vibreur, batterie, bluetooth, ...)

Caractéristiques d’un appareil mobile

@ Un processeur a puissance limitée
Une RAM et des capacités de stockage limitées
Un écran avec une résolution fixe

Des colits élevés de transfert de données

Une batterie a autonomie limitée




Exécution sur un appareil mobile (2/5)

Etape 1 : Installer le driver de "appareil

1. Aller a : http://developer.android.com/tools/extras/oem-usb.html#Drivers

2. Choisir le constructeur de I'appareil et cliquer sur le lien correspondant
3. Suivre les instructions pour installer le driver approprié

C 1) | & Sécurisé | https://developer.android.com/studio/run/oem-usb#Drivers
an [ . .
[ [] Developers Platform Android Studio
"
DOWNLOAD WHAT'S NEW USER GUIDE PREVIEW
Meet Android Studio Ge’[ OEM drivers

Workflow basics
Manage your project
Wit it a OEM Driver URL

Build and run your app

_ Acer hittp://www.acer.com/worldwide/support/
Overview
Run apps on the emulator ALCATEL ONE TOUCH http://www.alcatelonetouch.com/global-en/support/
Run apps on a hardware device
‘ Asus http://support.asus.com/download
Overview
Install OEM USB drivers Blackberry https://swdownloads.blackberry.com/Downloads/entry.do?

Get the Google USB driver code=4EE0932F46276313B51570F46266A608

Create run/debug configurations " &
4 9 g Dell http://support.dell.com/support/downloads/index.aspx?c=us&cs=198&I=en&s=dh

¢ TSN


http://developer.android.com/tools/extras/oem-usb.html#Drivers

Exécution sur un appareil mobile (3/5)

Etape 1 : Installer le driver de "appareil

Installer le driver pour les appareils Google (ex : Nexus 5)
1. Ouvrir le SDK Manager

2.  Extras > Google USB Driver > Installer le package

3. Aller a [CHEMIN_DU_SDK]\extras\google\usb_driver

4. android _winusb.inf @ > Installer les drivers

Installer le driver pour les appareils Samsung (ex : Galaxy S6)
1. Aller a http://www.samsung.com/us/support/downloads

2. Choisir le modele de I'appareil > Get Downloads
3. Downloads > USB (Driver) ver.x.x.xx.x > Download (EXE)


http://www.samsung.com/us/support/downloads

Exécution sur un appareil mobile (4/5

Etape 2 : Activer le déebogage USB dans |"appareil

y e ® © "M w1545 ® O "d u 1546 e ® O "d wu 1545 ® O "d u 1548 O © "4 @ 1642

Parameétres Q i A propos du téléphone H Paramétres Q

Envoyer commentaires sur appareil

@  Langueet saisie &€  Sauvegarde et réinitialisation
Numéro du modéle
Nexus 5
€  Sauvegarde et réinitialisation Systeme ;
i ? o "
Version d'’Android Autoriser le débogage USB ? Autoriser le débogage USB ?
6.0.1 "
Q] Date et heure Le débogage USB est concu Empreinte numérique de la clé RSA de
Systeme uniquement pour le développement. l'ordinateur :
Niveau du correctif de sécurité Android Utilisez-le pour copier des données 43,83582_F3'43.F0 44:C8:E1:52:0A:7F:
5 octobre 2016 entre votre ordinateur et votre Z3:05:61.05
@ Date et heure T Accessibilité appareil, installer des applications ID Toujours autoriser sur cet ordinateur I
sur votre appareil sans notification
Version de bande de base et lire les données de journal.
. s MB8974A-2.0.50.2.30 -
T Accessibilité [ ] Impression ANNULER
Version du noyau
- - 3.4.0-gcf10b7e
[=] Impression id-build@w #1 s Options pour les développeurs
Mon Sep 19 22:1
@  Apropos du téléphone Numéro de build x7 @  Apropos du téléphone
M4B30Z




Exécution sur un appareil mobile (5/5)

Débogage sans-fil : Exécution sur un appareil via le Wi-Fi

Débogage sans-fil : Exécution sur un appareil via le Wi-Fi
1. Installer le plugin ADB WIFI :
o File > Settings > Plugins > Browse repositories > ADB WIFI > Installer
2. Connecter I’appareil au PC par cable USB et au méme réseau Wi-Fi du PC

3. Activer le plugin:

@ Tools > Android > ADB WIFI > ADB USB to WIFI

n VCS Window Help

& Tasks & Contexts 4 S AP o L ? 8
Save File as Template... dSanrce
'1\;: Seaceate wmbce ashboardxml % [ £> activity_dashboard.xml X :;AndroidManifest.xml X c
= New Scratch File... Ctrl+Alt+Maj+ Insérer = =
= IDE Scripting Console
* Firebase Sk USSS- TeSponse

&2 App Links Assistant

} ADB Idea > ADB Restart Ctrl+Alt+Maj+R
return sum :I € Sync Project with Gradle Files

return null; i#@' Android Device Monitor



Types d’applications sous Android

Applications de premier plan

e Utilisable quand elle est visible et mis en pause
lorsqu’elle ne I'est pas

o Exemples: Jeux, Apps de cartes géographiques

Applications d’arriere-plan
o Interaction limitée en dehors de sa configuration © W u 1285

Settings Q

o Exemples: Alarme, Filtrage d’appels, réponse
automatique aux SMS, ...

Widgets

o Composant visuel interactif que les utilisateurs
peuvent ajouter a leur écran d’accueil

o Exemples: Affichage de I'heure, prévisions météo C m! Gza.\



TPO : Execution de 'application

¥ s.00

A map~-| |4 & G B K

2. Sélectionner l'appareil d'exécution

Hello World!

# Select Deployment Target

YWT-xis disakled in BIOS,

Connected Devices




Quelques liens utiles

Configuration avec Gradle
e https://rominirani.com/gradle-tutorial-part-6-android-studio-gradle-c828c5639bb

Processus de développement

e https://github.com/dogriffiths/HeadFirstAndroid/wiki/How-Android-Apps-are-Built-and-
Run

Top 5 des émulateurs Android
e http://appinformers.com/android-emulators-pc/13028/



https://rominirani.com/gradle-tutorial-part-6-android-studio-gradle-c828c5639bb
https://github.com/dogriffiths/HeadFirstAndroid/wiki/How-Android-Apps-are-Built-and-Run
http://appinformers.com/android-emulators-pc/13028/
https://rominirani.com/gradle-tutorial-part-6-android-studio-gradle-c828c5639bb
https://github.com/dogriffiths/HeadFirstAndroid/wiki/How-Android-Apps-are-Built-and-Run
http://appinformers.com/android-emulators-pc/13028/
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http://www.genymotion.com/
http://www.genymotion.com/

Prochain chapitre

Chapitre 4 : Langage Java et programmation orienté objet c_‘?__-_—ij Java

—

Objectifs :
@ Comprendre le paradigme orienté objet
@ Programmer des classes JAVA

@ Utiliser la bibliothéque de Java Standard Edition (JSE)




